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copyrighted © by Mini'-app'les. Articles may be repro
duced in other non-profit User Groups' publications
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Questions -. Please direct questions to an appropriate'
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Rates box within this issue.
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55343 or upload them to our BBS at 824-4394.
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manufacturer. The opinions, statements, positions, and views herein are those of the author(s) or editor and are not intended to represent the
opinions, statements, positions, or views of Apple Computer Inc., or any other computer manufacturer. Instead of placing a trademark symbol at
every occurrence of a trade-marked name, we state that we are using the names only-in an editorial manner, to the benefit of the trademark
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Payroll Service
(16% to 26% Savings from

Other Payroll Services)

(612) 823-6713
Ask for Ardie

BookkeepingService
(No job too small)

A/R—A/P—Trial Balance
Invoices/Statements
Bank Reconciliations

Laser Printer

Members
elping

Members
The Members Helping
Members section of the
newsletter is currently
undergoing construction.
Interested members who
would like to be included
on the new list should
contact Nick Ludwig at
349-0206 or through the
Mini'app'les BBS' new number
824-4394.

iffurar
'onsrmcT/on

Newsletter Ad Rates
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Frequency discounts 6 months at 5%, 1 year at 15%,
Mail inquiries to: PO Box 796, Hopkins, MN, 55343

Phone inquiries to: Nick Ludwig 349-0206

0$ \

Cactus Software &
Communications, Inc.
"Sharp and to the point"

Documentation Services for:
Computer Sof tware Technical Manuals

Mechanical Systems Training Courses
612 / 757 -6916 Fax 757 -4515
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March Mac eDOMs
compiled by Bruce Thompson

Mac eDOM #921 - Print Utilities

Copyright © 1995 Mini'app'les
MAR 1995

eDOM #921 - Print Utilities is a
collection of printer utilities that
enable you to do some things that
you can't even do with QuickDraw
GX.
DiskPrint 1.0

DiskPrint is a printer driver that
allows you to print to disk as a PICT
file or as a standalone application
that can be transmitted to someone
else. The application that is created
by DiskPrint will display and print
your original document without the
original application. It can be used
with all applications, all Macs, and
all system software versions.

DiskPrint has the same interface
as other printers and is accessed
through the chooser as any other

printer.
Ecco Maker

'Ecco Print' is a no-frills network
driver for single-user printers. Its
component pieces are created by the
enclosed application, 'Ecco Maker'.
Ecco Print has been tested successful
ly with the ImageWriter and the
StyleWriter. It does not work with
the Personal LaserWriter LS.

Ecco Maker allows you to install
either a 'server' System Extension or
a 'client' printer driver on Macs con
nected to AppleTalk networks. On a
server Mac, Ecco Maker creates both
a new printer driver and a System
Extension which will install a
AppleTalk server. This server allows
the newly created Ecco printer driver
to be accessed by Ecco Print clients
across the network. After it finishes
installing Ecco Server, Ecco Maker
reminds you to select the Ecco print
er driver in the Chooser. The server

will be installed the next time that
you restart your Mac.

On a client Mac, Ecco Maker cre
ates a new printer driver customized
for the selected printer. You are then
reminded to select this new driver
via the Chooser. The Chooser will
display a list of available Ecco Servers
for you to select from. Because the
clients will be looking to select a
server in Chooser, it is best to install
the server before installing clients.
MOM & DAD'S EASY ENVELOPE
PRINTING

First things first. In order to use
MOM & DAD'S EASY ENVELOPE
PRINTING, you must have a printer
that can specify an ENVELOPE of
any size in the Page Setup box.
Printers such as the HP DeskWriter,
Apple's LaserWriter, etc. all have this
in their Page Setup and can use
MOM & DAD'S EASY ENVELOPE
PRINTING. MOM & DAD'S EASY

Computer Consultation
Specializing In

Macintosh & Windows
Operating Environments

Small Project̂ ,

Competitive Prieim

Prompt Answers T
Types Of Computer

Questions

ANNOUNCING HANDS ON INTRO CLASS ON THE INTERNET
This past summer I (Keven Kassulker) visited 5 school districts. St. Louis Park had by far the
best lab with a network of 20 Power Macs fiber-linked directly into the Internet. Our
classes feature a two instructor format to avoid the long waits for help during the
accelerated lab sessions. The lab is fully utilized and the class size builds excitement and some
good networking. From discussions at past consultants meetings I knew Mike Carlson had
spent more time with the Internet, so I hired Mike to produce the bulk of the curriculum.
The up coming Internet 101 class will be the second time Mike and I have taught the class.
Common comments on the evaluations from the 1st session were, 'great but please lengthen
the class'—so we are now also offerir.J Internet 201!
St. Louis Park Community Education INTERNET class offerings:
H-702 Internet 101-Twin Cities Access I Intro. Mon Apr 17 & 24th
(Both text & GUI access methods discussed and used during labs, along with information
about local service offerings.) Use popular programs such as Gopher, Pop Mail, Mosaic, and
get a brief World Wide Web exposure.
H-703 Internet 201 Intro Information Highway! Wed May 10 & 17th
(Primarily coverage of GUI tools & World Wide Web) More access methods discussed along
with comparisons of different tools and providers.
Plenty of lab time to use World Wide Web tools such as Mosaic and Netscape.
All classes held @ St. Louis Park High School Room C250B from 6:30pm to 9:30. Fee $52
Credit Card Registration 928-6416 or Fax 928-6447 or mail check to School District 283,
Lenox Community Center. 6715 Minnetonka Blvd. St. Louis Park, MN 55426-3499
For more information or directions call Allyson Rudy 928-6419 or Keven

Keven Kassulker
TOTAL Automation, Inc.
7779 48th Ave. N., New Hope, Minnesota 55428-4515
(612) 535-2968 or (612) 533-5884
E-Mail Address: kevenkassu@aol.com

New clients of Total Automation can get 50% discounts if they mention that they are
Mini'app'les members. Also if a Mini'app'les member gives me a qualified referral I'll give
member & referral each a I yr membership.

Mini 'app' les Newsletter Apri l , 1995



ENVELOPE PRINTING automatically
adjust to envelope size selected.
Printer's like the ImageWriter don't
have this, and thus can't as yet use
this program, (ed. note - see PREC
Manager)

Some features that are in MOM &
DAD'S EASY ENVELOPE PRINTING

> Multiple mailing lists - set up a
different list for every occasion

> Print one name or print them
all! No need to print all those names
for just 1 envelope

> Stores your return address as a
default

> Sorts Mailing List on :Name,
address, city, state, or zip and up or
down

Enhancements in version 1.5
> Exports Mailing lists to a tab-

deliniated text file
> Allows for multiple selections

in a mailing list. Now you can print
any combinations for names in a list.
PREC Manager

A PREC (Print RECord) is a
resource stored inside a file. The
PREC resource holds the information
on what size paper you are going to
print on. The standard ImageWriter
driver has room for 6 different paper
types, and you can set how many of
the six will display. Note that
although you can set the number
that are 'active' to less than 6, the
PREC itself always contains 6. Apple
provides a standard PREC resource in
the ImageWriter file, which has 5 of
the 6 paper size choices enabled.
With PREC Manager you may modi
fy and create your own PREC
resources. (You can remove existing
PREC resources with it too.)
Preview™

Preview is a chooser-level printer
driver for the Macintosh Computer.
Unlike other Macintosh printer dri
vers such as the LaserWriter,
ImageWriter or Macjet that send the
output to a particular printer,
Preview sends the output to the
Macintosh screen. This enables the
user to see on his screen exactly
what is going to be sent to the print
er. Although some Macintosh soft

ware come with their own preview-
like function, Preview is application
independent so no matter which
application you are in, you will
always have access to Preview.
Preview is installed just like any
other printer driver such as Macjet.
You simply drag its icon into your
System Folder and Preview is
installed.

The Preview-Switch FKEY is
included as a convenience to the
Preview user. It is used to quickly
toggle back and forth between your
regular printer driver and Preview
with out having to go into the
Chooser. By default, the Preview
Switch FKEY is numbered as FKEY-6.
In this case, to switch from your nor
mal printer driver, such as the
LaserWriter to Preview you just hit
the key combination of command-
shift-6. After you've done all the pre
viewing you wish to do you simply
hit command-shift-6 again to toggle
back to the LaserWriter.
Print2Pict 3.5

This is version 3.5 of Print2Pict. It
is a printer driver that previews and
saves printed pages to PICT files or
the clipboard. It works only under
System 7 or later. Drop it into your
extensions folder and select it with
the Chooser. It has an online help
you can copy to the clipboard and
print using any word processor. You
can use Print2Pict with any applica
tion that prints using the standard
Macintosh interface. There is also an
option to save the pages into a
standalone application (PostCard),
which can then be sent to anyone
who can read and/or print it without
the original software.
Printer Defaults

Printer Defaults is an application
to modify the default settings in
printer drivers. It has been tested on
various machines running systems
7.0. Land 7.1 with a large number of
different printer drivers including
LaserWriter 8.0 and 8.1.1. Printer
Defaults works by reading in the
default settings for the TPrint Record
stored in the resource of type 'PREC

with ID 0 in the driver and then
doing a Page Setup. Any changes are
written back to the driver become its
new defaults.
Printer Remote DA

This DA lets you control a serial-
port-connected ImageWriter from
your computer, without getting up
and doing it manually. (Ed. note - It
appears to control line feeds, form
feeds, etc.) Does NOT work with
AppleTalk ImageWriter II's.
SaveATreel.52

Save A Tree is a text file printing
utility designed to conserve paper by
printing on 1 page what would nor
mally use 2 or 4 pages. Since Save A
Tree only handles TEXT' files, I
expect its primary audience will be
programmers printing source code.
Although, the word wrap option
makes it useful for general text print
ing too. (Editor's note... Be sure to
set "print wrap" on for general pur
pose printing). Because of the small
font sizes used, Save A Tree works
best on high resolution printers.

Simple Label 2.1
I wrote this program because I

was having trouble getting my
StyleWriter to print labels. The prob
lem is most label programs consider
each label its own page and since the
StyleWriter will not print on the very
top or bottom of the page you could
not get a complete label. Some pro
grams (that did not use the above
page method) would only print at
ImageWriter Quality. Other High
Output Quality programs would
only look on a Network for a
LaserWriter, since that is not where
the StyleWriter lives they could not
see it. I'm sure there are several com
mercial label programs that will do
the simple tasks that I wanted, but
that would be like killing a fly with a
hand-grenade.

The task that I wanted to perform
was to print multiple copies of the
same label (for return address labels).
That is what this program does. If
that will fill your needs this program
is for you.

Mini'app'les Newsletter April, 1995



SWIIPrintUseMon
This utility silently monitors the

number of pages printed and warns
you when your StyleWriter ink car
tridge is close to running out, so that
you can either refill or replace it.
SWIIPrintUseMon examines a file
called 'StyleWriter II Log' (Note: this
file has different names on foreign
language Systems; see the section on
Installing it). This is a TeachText
document that is created by the
StyleWriter II installation disc, and
updated by the StyleWriter II driver,
whenever a document is printed.
Each time you print something on
the StyleWriter, the driver adds an
entry containing the number of
pages that were printed, the time,
the application that printed them,
and so on.

SWIIPrintUseMon processes this
file, totals up all the pages printed
and ends up with the grand total
printed so far. If the total number of
pages printed is greater than a pre
defined number (default 300), a
warning message is displayed in a
window. If the number of pages
printed is less than this number then
the Application exits with no mes
sage (and without creating a win
dow).
Watermarker demo

Working Watermarker allows you
to place a "watermark" graphic such
as "Confidential", "Draft" or a com
pany logo behind anything you
print. The stamp may be light gray
or it may be full darkness for use as a
letterhead. This demo comes with a
single watermark. The real product
comes with several dozen example
watermarks, and allows you to create
your own from PICT or EPS graphics.

Mac eDOM #922 - File Control
Copyright © 1995 Mini'app'les
MAR 1995

A couple of the more popular file
manipulation programs.
File Buddy 2.2.1

File Buddy 2.2.1 provides four
main areas of functionality: Get Info,
file finding, file manipulation (mov

ing, copying, and deleting), and disk
cleaning. All are discussed below. File
Buddy can exhibit several different
behaviors when one or more items
are dropped on it in the Finder.
Dropping an alias has the same
effect as dropping the item it aliases.
GET INFO

File Buddy provides an extensive
Get Info dialog. It presents the user
with information about files, folders,
and disks. Rather than go into a long
explanation of the info it gives you,
I'll just let you drop a few items on it
and see for yourself.
FIND ORIGINAL

Drop aliases with this option to
find the items to which they point.
FIND SIMILAR

Sometimes you want to find
items that have something in com
mon with another item. Using the
Find Similar option on a dropped
item loads every aspect of that item
into the Find window. You can then
select the pertinent characteristics
and do the search.

MOVE/COPY...
Displays a variation on the put

file directory dialog box that lets you
move or copy the dropped items to
another directory. Items can only be
moved to other folders on the disk
on which they reside.
MOVE TO DESKTOP

Moves items to the desktop.
Disk Cleaning
Find Unattached Aliases...
Delete Empty Icon Files...
Find Empties
Scan Preferences Folder
Rebuild Desktop File

FileTyper 4.1

FileTyper is a small "drop box"
program that you can use to quickly
change types, creators, and Finder
flags.

SO HOW CAN I USE FILETYPER?
> Solve the mystery file! That

darn file with the generic icon and
"application not found" finally iden

tified!
> Bum your Hand-Off II! Want to

map your MacWrite 5.0 files to
MacWrite II? Just drop them all onto
FileTyper at once and change all
their creators to "MWII" with a sin
gle click!

> Don't want casual users snoop
ing into that folder full of private
files? Drop it on FileTyper and set
the "invisible" flag in seconds!

> Ever wonder how people create
those TeachText documents with the
newspaper icon that can't be edited?
It's simple! Just drop it onto
FileTyper and change the type from
"TEXT" to "ttro".

> Want to lock fifty word process
ing files without having to "Get
Info..." on every one? FileTyper will
lock them all at once, faster than a
Finder 7 window redraw!

Mac eDOM #923 -It's Time
Copyright © 1995 Mini'app'les
MAR 1995

eDOM #923 - It's Time is a collec
tion of clocks that do things a bit dif
ferently.
Invisible Clock (Female)
Invisible Clock 2—Male
by Chris Holmes

Invisible Clock is a small System
7-only Apple Macintosh application
which audibly announces the time
between the hours you choose every
hour, half-hour, or quarter-hour as
you prefer. You may want to put
Invisible Clock (or an alias of it) into
the Startup Items folder of your
System Folder to automatically start
the clock every time you turn on
your Macintosh.

To configure the time announce
ments, choose Preferences from
Invisible Clock's Edit menu. Use the
From and Until fields and radio but
tons to specify the hours between
which you'd like to hear the time.
You can also make Invisible Clock
speak in your own voice by record
ing new sounds for the files
"Invisible Clock Sounds" and "More
Invisible Clock Sounds" with a
sound editing program such as
SoundEdit Pro.
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WorldClock Lite
What time is it in Alice Springs,

Australia? How far away is London?
Is it daylight or night time in New
York? When is sunrise tomorrow?
Sunset? When what time will the
moon rise in Boston on March 3,
1998? How many hours of daylight
today in Whitehorse, Yukon,
Canada? What is the date of Full
Moon in October, 1997? New Moon?

The WorldClock Desk Accessory
is a "pop-on-the-screen" display with

the answers to all these questions
and many more. Attractive, fascinat
ing, functional, WorldClock deserves
a place in the fl menu of every
Macintosh.

The file for WorldClock Lite has
been deliberately kept small (few
illustrations) in order to minimize
modem transmission time and
download costs. The full version of
WorldClock is shipped with a larger,
illustrated documentation file.

GS eDOM #73 & 74
by Harry Lienke

Apple II GS Edom # 73

Boggled is similar to the Boggle
game sold commercially; you must
make words from a random set of
letters. You have three minutes in
which to find more words than the
computer does. Each turn is scored.

Bombs.GS is an arcade style
blow-'em up game. You guide a char
acter wearing a bomb dropping suit.
You have to find your way through a
maze to gather the riches.

ColorMind is Mastermind pro
grammed for the Apple II GS. The
game is done up in French but since
everyone knows how to play
Mastermind, the language is not a
barrier to matching the colors.

Stalactites is a shoot-'em up
arcade game. You must out-gun
waves of alien intruders at the same
time that you keep the evil stalactites
from growing down to the ground
and cramping your style.

Some of these programs are
shareware. If you decide to use a
shareware program, you MUST send
the fee to the author. There aren't
many people still writing new soft
ware for the Apple II GS so it's
important that we support them
whenever we can.

Apple II GS Edom # 74
By Harry Lienke

This is a collection of Desk
Accessories, Finder Extras, and so
forth, that can perform a wide vari
ety of tasks for you. Some of them

are very practical and you will proba
bly put them into every day use.
Some of them are simply fun and
you may decide to trash them after
executing them a few times. Some of
them are useful under very limited
circumstances and you may not even
execute them once.

Mac Sound Grabber lets you
convert sounds from that other
Apple computer so that you can use
them on your GS.

Sensible Sounds provides spoken
messages to associate with the events
happening on your GS. For example,
with these sounds your GS will tell
you when a disk has been inserted
instead of just whooshing at you.

Super Info 3.3 is an encyclopedia
of information about the Apple II GS
and its system software.

Two Apples provides a second
Apple Menu; the second menu is
sorted in reverse alphabetical order
so that the desk accessories which
are at the bottom on one menu are
at the top in the other.

These are just some of the pro
grams included on this disk. Try
them all and see how useful and
how silly your GS can be!

Some of these programs are
shareware. If you decide to use a
shareware program, you MUST send
the fee to the author. There aren't
many people still writing new soft
ware for the Apple II GS so it's
important that we support them
whenever we can.

REMINDER
Club members are reminded that,

while eDOMs are usually available at
all club meetings, they are also avail
able by mail. You can use the
"Mini'app'les Handy Form" near the
back of the Newsletter. Also, if the
disk you want is temporarily unavail
able at the meeting, you can pur
chase it there and it will be sent to
you.

NDA games
by Nathan Mates

Mine Hunt vl.2

The object of Mine Hunt is sim
ple. You are located at the upper-left
corner of a minefield and the only
help you have is a barely functional
mine detector. Your mine detector
can only sense how many mines are
adjacent to your current square,
including diagonals. For help during
the game, press the "?" key.
MultiTris v0.9

In yet another saga of the contin
uing series of Tetris Spinoffs, Nathan
Mates presents: MultiTris. Instead of
a certain fixed number of blocks per
piece, MultiTris generates each piece
on the fly, allowing for varied play
that is never the same. In addition,
two special pieces serve to tantalize
you.
Power Grid vl.0

Congratulations! You have just
been put in charge of connecting the
power plants to the towns by your
local power board. The only problem
is that the power connections come
in many different shapes and disap
pear after providing power to the
towns. How long can you provide
power?
Accentlt! vlO
by Rolf Braun
Released by Sassy Software 12/11/94

This is public-domain freeware.
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What is Accentlt?
It seems some programmers just

do not get the message. Apple has
specifically stated more than once
that all of Battery RAM is reserved
for system use. But some hackers
have used it for their own purposes
without asking Apple for an allot
ment of BRAM. Therefore, when
Apple released System 5.0 and key
translation was introduced, some
programs continued to overwrite
location $5A which contains the key
translation information. This does
not show itself until you are writing
that big report, and then boom, you
cannot use accented or umlauted
characters. You then have to go all
the way into the Control Panel, and
if you are like me, and your Control
Panel DA is normally not activated
because you shift-booted, that means
a lot of hassle and a possible reboot.

Enter Accentlt. Accentlt is a tem
porary init file (TIF) that will instant
ly change BRAM location $5A to
$00FF which specifies standard trans
lation. That is it. You can then use
accented characters. You probably
will want to put this on your Shifty
List if you have Shifty List by Eric
Shepherd, a wonderful utility that
lets you install SOME inits and DAs
when you shift-boot. Shifty List is
available on SoftDisk G-S issue #57.

Fix-Quit Finder Extension (Fext) vl.O
Written by Greg Betzel, 11/06/94
(c) 1994 by SnakeByte Software. All
Rights Reserved.

This program contains material
from the ORCA/Pascal Run-Time
libraries, (c)1986-1994 by the Byte
Works, Inc. Used with permission.

FreeWare!!
What Is Fix-Quit?

Fix-Quit is a simple Finder
Extension (Fext) that moves the
Finder's "Shut Down" menu item
out of the Special menu & puts it
into the File menu (where "Quit" is
usually located in most GS pro
grams).

Why Fix-Quit? Many people have
asked that the Shut Down menu
item be moved. This can be done

easily, IF you have a resource editing
program, AND you know how to use
it, AND you know exactly what
you're doing with it. Unfortunately,
few people meet all of the above
requirements.

Fix-Quit is an attempt at an easy
solution to this problem. Rather
than having to mess around with
the Finder's internal data, all you
have to do is drop Fix-Quit into the
FinderExtras folder on your boot disk
(see instructions below), and Fix-
Quit will move the Shut Down menu
item automatically for you. Voila!:)

RemovAltDispMod vl.0.1
by Jay Krell

RemovAltDispMod is a tiny init
that simply removes the seldom used
Alternate Display Mode from the
CDA menu.
Kill da Whoosh vl.0
by Nathan Mates

DEATH TO FLUFF!
System 6.0 and later have this

annoying little piece of System fluff:
the "Whooshing" rectangles when
ever a program is launched from the
Finder, when a Control Panel is
opened, etc. I think it's a waste of
time to do them, and play any asso
ciated sound effects. So, I wrote up a
short init to kill them.

KillDaWhoosh is small, simple
Control Panel that needs to be
installed in the CDevs folder inside
the System folder on your Boot disk,
and your system rebooted. You
should be able to launch, install, and
open KillDa Whoosh merely by dou
ble-clicking on it from the Finder.
After installing itself, KillDaWhoosh
will either allow or eat all whooshes
that are part of the system calls.

LE.FIX
by David A. Lyons

LE.FIX is a public domain utility
that will prevent mysterious crashes
from occuring while (or after!) run
ning programs which start up the
Line Edit toolset incorrectly. After
starting Line Edit incorrectly, almost
anything can happen. Sometimes
there are no [apparent!] ill effects;

sometimes the application crashes
right away; sometime a crash will
not occur until much later.
Window Spy Finder Extension Version
1.3
by Greg Betzel
(c) 1994 by SnakeByte Software, All
Rights Reserved.
Freeware!!

What Is Window Spy?

Have you ever wished that you
could see the titles of partially hid
den or buried Finder windows?
Window Spy is a unique utility that
allows you to do just that. When
Window Spy is open (see instruc
tions below), it will show the title of
whatever window happens to be
directly under the mouse cursor. A
real help-out for cluttered Finder
desktops.
XManager
by Bill Tudor

XManager is an Apple IIgs Finder
Extension init file that allows you to
manage all your other Finder
Extensions. You can check on the
current memory usage of installed
extensions, and you can install and
remove them "on the fly" while the
Finder is running.

Lend
Electronics
for April Main
Mac SIG
Meeting

Representatives from this
local electronics company will
demonstrate products for the
Macintosh. Lend has recently
merged with Pilot
Technologies to provide prod
ucts for Powerbook battery
charging, portable power
cables, desktop Powerbook
(Duo) docks, and network
cabling solutions.
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Tine a^ain for the Swap Meet/

N h e n : H h e r e i C o s t s
Saturdau- Apache Plaza Shopping Center
Mail 6,195)5 - 3800 Silver Lake Road Slight change in pricing over the
l o a n t o I p n P a s t u e a r s . . .

Yes, members from that other computer user group, TC/PC, will Menbers: $5 for 1/2 table
be joining us for our Spring Swap Meet.

Members reserving tables before April 21th have the option of $10 for full table
1/2 or full tables. After April 21th, only a full table at $10 may be
available. Please call for a table reservation as early as possible to Non nenbers: $10 for 1/2 table
allow us to make our arrangements with Apache Plaza in advance. ... , e .. . ..
T h a n k y o u ! $ 2 0 f o r f u l l t a b l e

If all goes as planned at the shopping center, we may have to kj mpnhpr
dodge some bobcats and back hoes. There will be some other
doings at Apache, but should be no problem in getting us in. May business! $25 for full table
just be in a different area than the center stage area that we've used
several times.

See Shows & Expo's on the Club Bulletin Board for additional information. Or if you would like to save your
table or got other questions, please leave Tom Gate a message on the Mini'app'les Voice Mail line at 229-6952. (If
you would like to skip the greeting, press 1 on your touch tone phone to immediately begin recording your message. Hang
up to send your message).

See you on Mav 6th!

Hayes Offer
Hayes has made the following User Group Special

Offers:
•Hayes ACCURA 144 + FAX 144 (PC)
• Hayes ACCURA 144 + FAX 144 (Mac)
• Smartcom BBS Dialer $ 14.95
• Smartcom Data/FAX PRO $59.00

S89.00
$89.00

• Smartcom II for the Mac $49.00
• Shipping and Handling is $10 per unit/hardware, $6
per unit/software

Limit 2 per item. Payment with Check, Money
Order, Visa, or MasterCard. Offer ends 30 June 1995.

Forms will available at the Main Mac SIG and Mac
Novice SIG meetings. Check the mini'app'les BBS for
other locations where this form will be available. Offer
is good only to members of computer users groups.

Ongoing Deals for
Mini'app'les Members
Submitted by Tom Gates

The following businesses have agreed to provide
ongoing discounts to members of Mini'app'les. When
you contact these companies, please identify yourself
as a member of Mini'app'les to qualify for these dis
counts. For questions related to these discount offers,
please contact Tom Gates - (612) 789-1713 evenings
and weekends.
APC Power Protection Products

Surge Protection strips, Battery backups, line condi

tioners, etc. Contact Keith Kalenda at Business Security
Products (612) 789-1190. 1/3 off SurgeArrest line of
products 25% off BackUPS, SmartUPS and related prod
ucts
MacMillan Publishing

35% discount off computer books from QUE, Sams,
New Riders Publishing, Hayden and Brady. Catalogs
available thru Mini'app'les or by contacting Marcie at
1-800-428-5331 x3744. To place orders, contact
Melissa at 1-800-428-5331 x4673.

MacMillan Publishing produces frequent listings of
new titles that have been added to their catalog.
Mini'app'les will attempt to have these available on
the BBS in addition to the catalogs.
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Main Mac Meeting Minutes
09 February 1995
by Tom Ostertag

I arrived in plenty of time for the
meeting at Washburn Library to find
a group of women receiving a lecture
and not recognizing any of them
realized I was suffering from geo
graphical coordinate deficit. A quick
look at the Calendar in the
Newsletter and some additional loca
tion repositioning to Southdale
Library and I recognized Mike
Carlson helping a gentleman carry in
some computer equipment. I
grabbed a box and headed up the
stairs to the meeting room hopefully
to avoid being asked if I'd gotten
lost.

Mike started the meeting on time
with announcements that included
the Trailheads Jamboree to celebrate
the release of Oregon Trail II on CD-
ROM. It will be on 25 February at the
Mall of America from 12:00 to 5:00
at the Event Center. Midwinter
Maddness at the National Sports cen

ter was also announced and instruc
tions to get there were given. Denis
Diekhoff also mentioned the deals
available from the National User's
Group Connection.

Next were Questions and
Answers... TechTools usage was dis
cussed in how to run the program
while background printing programs
were on. Several suggestions were
given. A question was asked about
the preview function in Calendar
Creator running on an LCII with an
ImageWriter II printer. It was sug
gested to used a LaserWriter configu
ration to do the preview. A Q&A
about rebuilding desktops and loos
ing the ability to open pictures with
TeachText was answered by an
attendee offering to post a program
entitled BNDLBanger. to repair the
lost connections. A hardware ques
tion on Torx drivers was answered
by suggesting that Torx heads be
superglued on to a regular Phillips
screwdriver for opening cases.

As the clock relentlessly ticked on
it, Mike announced Clayton Scheuer
of TRACE Technology Corp. Clayton
had the hardware (computer and
graphics tablet) and Painter 3.0 to
demonstrate what a high end graph
ics program could do. He proceeded
to show us most of the unique utili
ties and then some.

Mike drew the demo to an end
and after Brian Bantz made an
announcement about the Annual
Meeting on 18 March, the equip
ment was packed up and the crew
headed for Pie SIG at Baker's Square.
A short discussion of Apple II
Hardware and software ensued after
which the topics varied from bul
letin board usage by relatives to how
slow deliveries can seem when one is
anxiously awaiting a new computer
or computer accessory. The pie was
okay and the conversation was even
more interesting...

Main Mac Meeting Minutes
09 March 1995
by Tom Ostertag

I arrived in plenty of time for the
meeting at Washburn Library only
to find a small army of people set
ting up a table full of computer
equipment. Mike Carlson started the
meeting at 7:05 with the statement
"Let's get started..." Mike asked new
people to introduce themselves and
then asked for general announce
ments. Brian Bantz talked about the
General Meeting at the Southdale
Library on 18 March. A representa
tive from MultiTech will come and
talk about telecommunications. A
request for resume's of nominees was
also requested for the April
Newsletter. Mike announced that
Lend Electronics would be the pro
gram for the April Main Mac SIG
Meeting at Washburn Library. Lend
Electronics will demonstrate prod
ucts for the Macintosh.

Next came Questions and
Answers... The first one was on how

to put a 6115 Performa to sleep.
(Singing it lullabies is not the correct
answer...) Second was a question on
how to configure a serial port for
both modem and Fax communica

tions. (Software upgrade...) Third was
some comments on Word 6.0.

Mike then introduced Greg Dalen
of Gibbco who then proceeded to
use the large collection of computer

Digital fun at the March Main Mac Meeting,
Jack!!!

curtosey of Denis Diekhoff Smile Pam and
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equipment assembled in the front of
the room. Amongst products that he
demonstrated were the Newton 120,
(Bob Demeules got the Newton jack
et) RAM Doubler, The Quick Cam
from Connectix, Bose speakers,
Asante Networking products and
TDK PCMCIA modems. After the
demos, Greg passed out door prizes

to everyone... disks, RAM Doubler,
Newton Hats and TDK Media T-
shirts.

By this time the librarians were
walking through the doors and so
there was a flurry of activity to pack
up all the computer equipment. The
Pie SIG was announced for Perkins as
we headed out the door.

Lots to talk about at Pie SIG...
condemned property and roads,
RAM upgrades vs. RAM Doubler,
Digital Photography, (Speaking of
which... Denis Diekhoff has a digital
photo of the crew... Pam Lienke and
Jack Ferman are looking the other
way.) and networks.

All for now...Tom Ostertag

March ClarisWorks Meeting
By Pamela K. Lienke

Spreadsheet or Database? A
spreadsheet is a document arranged
in columns and rows, usually used to
work with numeric data and can
contain formulas that allow complex
"what-if" analyses of data. A data
base is a collection of data arranged
for ease and speed of retrieval. These
two became the question of the
night at the March ClarisWorks SIG.
We like to help people resolve prob
lems that they may be encountering
as they work with ClarisWorks. I
think that we all feel that it helps us
to learn more about the program.
With this in mind, John Hunkins
asked for advice. Well, he received
lots of opinions.

Clearly there are two ideologies
here. Much of the meeting revolved
around "helping" John display his

data in two ways. We worked to set
up a columnar report in the database
module and then took the same data
and converted it into a spreadsheet.
In the process we discovered a num
ber of interesting points about
spreadsheets, databases, and our
members. The spreadsheet that John
had already assembled had an inter
esting problem (i.e. The Mystery...
see below, the Editor) that several
members will be working on during
the month. You really had to be
there to get the flavor of the meeting
and the "discussion."

Our homework for the next
meeting is to work with the
Presentation Assistant. Extra credit
will be available for anyone coming
up with a presentation to be dis
played at the start of the meeting.
We also hope to have a demonstra

tion on line spacing in a word pro
cessing document. There is informa
tion about this in the March 1995
ClarisWorks Journal. See you at the
Southdale library on Tuesday,
April 4.

Pam Lienke
NB: Well, it was a mystery, but it

has been resolved. Turns out that
"Page View" was turned on. That
only allowed us to see as much as
would fit on a page, so when we
expanded the file, it wouldn't dis
play. When I toggled Page View off,
all columns were there.

One of those things that is easy
to overlook. When looking for the
more obscure solutions to a problem
it is often the simple ones we over
look.

Bruce T

mini'app'les HyperCard SIG Announcement
The April SIG
Monday, APRIL 10,1995, 7:00-9:00.

TOPIC: General Scripting Discussion

Bring problem stacks or scripts or
bring your current project and show
off your scripting skills.

I'm writing this before the March
meeting, so I don't know what the
turnout was like but if it was as low
as previous months, THIS MAY BE
THE LAST MEETING!

My vision for the HyperCard SIG
is for it to be a place for folks serious
about programming and interactive
design with HyperCard. We can
share scripting ideas and seek help
for scripting problems. You don't

have to be an advanced scripter but
you should have a desire to add to
your scripting knowledge and you
should have some scripting back
ground.

I've posted our meeting date to
the comp.sys.mac.hypercard news
group on the Internet and that has
aroused some interest. I'm hoping
some of these people will come to
the meeting.

We have a NEW LOCATION in
downtown St. Paul (but the same as
last month).

The Science Museum of
Minnesota moved its computer edu
cation labs and the HyperCard SIG
moved with the labs. The new

address is: American National Bank
Building, 101 E. 5th St., 19th Floor,
St. Paul, MN
DIRECTIONS & DETAILS

The building is at the corner of
5th and Minnesota in downtown St.
Paul. There is a ramp under the
building with an entrance on
Minnesota. (Minnesota is one-way
going north. Fifth Street is one-way
going east.) Parking will cost you $3
to $4. If you use the ramp, park on
the 4th level and enter through the
south door to the elevators. (This is
important! Doors on other levels will
be locked!)

You can also try onstreet parking
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as meters are free. To enter the build
ing, go to the 6th Street side, near
the Buttery Restaurant, and use the
entrance under the skyway. Find the
elevator and go to floor 19.

For directions on how to get to

this building from various points in
the Twin Cities, call 221-4722. You'll
get a recording listing various
options. You want option 2. (You
can also request a Science Museum
Computer Ed catalog, if you're

interested.)
For more info, contact Peter Fleck, 370-
0017, Internet,
<fleck@astl.spa.umn.edu>, or AOL
<PeteFleck>.

Thanks. Peter

Marathon
reviewed by Jeremy Roush

Mac owners have long suffered
with PC game envy. However, from
time to time, the roles are reversed
and PC weenies are seen staring for
lornly at colorful shrink-
wrapped boxes in the Mac
aisle. Like Myst before it,
Marathon is such a game.
Taking the first-person fight
ing concept born in the
Ultima Underworld series,
rehashed with Wolfenstein
3D, and made famous in
Doom, Marathon has set new
standards for 3D games, and
it is only available for the
Macintosh. No Wintel ver
sion is planned.

Developed by Bungie
Corporation, who created
Pathways in Darkness,
Marathon takes place on a huge
interstellar colony ship called the
UESC Marathon. Its mission is to
move through the stars and plant

human colonies on livable planets.
The game's story starts when an
alien ship appears suddenly, appar
ently using an FIT (faster-than-light)
drive, and attacks Marathon and the

colony currently under construction.
You are a part of the Marathon secu
rity team and are flying from colony

operations back to Marathon when
the attack begins. You barely make it
out of the airlock before the alien
ship blows your little craft into space
dust, where you then float into a

space dock and carefully enter
Marathon. There your battle
begins.

While perhaps only a
glimpse of what the future of
virtual reality games will be,
Marathon is truly an amazing
experience. All of the 27 lev
els offers both intense gun
play and challenging puzzles.
Each level is a huge enclosed
area, and some measure more
than 100,000 square feet of
space with lots of elevators,
stairs, transporters, switches,
and doors. You are given mis
sions to perform by Leela, one

of three artificial intelligences
that control the computer systems of
Marathon. She works with you to

(Continued on page 22)

About the mini'app'les BBS
One benefit of mini'app'les mem

bership is that each member is eligi
ble to establish a free account on the
Mini'app'les Bulletin Board System
(BBS). For example, you can commu
nicate with other members or offi
cers through electronic mail (E-mail)
or public messages. Or download a
program from one of the BBS' con
ferences or from the on-line CD-
ROM, called BBS in the Box.

Each account is allocated up to
45 minutes of connect time per day.
This time is non-cumulative, which
means unused time is not carried
over to the next day. When you first
log on, you will be asked for infor

mation to establish your account.
Until this information is verified,
you will have limited access.
Verification usually takes one or two
days (new members will take longer),
then you will be given expanded
access.

In January, the BBS moved. The
new telephone number is
(612) 824-4394. The BBS presently
has one line and is capable of con
necting with a modem with any
connection speed from 300 up
through 14,400 bits per second (bps).
You can use almost any text-based
terminal program; however, your
settings should be set at 8 bit,

no parity, 1 stop bit (8N1).
Macintosh and PowerPC users

have the added benefit of connect
ing with FirstClass™ software.
FirstClass™ software uses a graphical
interface which creates a communi
cation desktop. This software is avail
able from mini'app'les on diskette or
from the BBS in the Client Software
Folder which can be downloaded
before verification.

In the following pullout section,
we have reprinted the FirstClass™
User Reference Card which describes
the basic features. If you are new to
using the FirstClass™ software, this
card will quickly get you up to speed.
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Connecting
FirstClass

to

Starting FirstClass
To start FirstClass, open the settings docu
ment for the system you want to connect to
by double-clicking on the icon. You can also
click once its icon to select it. and then
choose Open from the File menu. A typical
settings document looks like this:

The FirstClass client application looks like
t h i s : . j a

j mJ L I
FirstClass© Client 2.5

Starting FirstClass displays the Login Form for
the system you've chosen. A typical Login
Form is seen on the right.

FirstClass" is an easy-to-use communication system for the Macintosh. With FirstClass you can send and
receive electronic mail, share files, use electronic conferencing to exchange ideas, and participate in on-line
chats. Because FirstClass uses the familiar Macintosh graphical user interface, you will find it fast, intuitive,
and easy to learn.

FirstClass consists of two parts: the client (you) and a server. To use FirstClass, you will need both a Settings
Document for the system that you want to connect to and the FirstClass Client application. You will also
need to connect to the server using either a modem or an AppleTalk network. Before you can actually use
FirstClass, you will need to log in. or connect, to the server.

Splash Screen
'litis contains information about the system that
you are connecting to.

SoftArc Online
fi

Progress Display
As the connection Ls established, the progress is displayed in this area. If you have any problems
logging in. contact your Administrator.

Login button
To begin the login process, entc
on the Login button.

User ID and Password
You must have a User II) and password to con
nect to a FirstClass system. Contact your
Administrator for details. On some systems you
can also auto register and set up your own I )ser
II). If you get tired of entering your User II)
even- time you log on. you can save il in the set
tings file by pressing the Setup button.

Setup Button
Press this button to change your settings. These
settings include information on how to connect
to the server and can include your User II) and
Password. Once you've established the correct
settings you need, there should be no need to
change them again. If you need help with ihc.se
settings contact your Administrator.

• User ID and your password, and click

The Desktop Once you have connected to the server, your FirstClass desktop appears on the screen, litis is the starting point
for using FirstClxss, just as the Macintosh desktop is the starting point for the Mac. To open any item on the
desktop, double-click on the appropriate icon. To close the desktop, either quit the FirstClass application or dis
connect from the system that you are connected to.

Window Summary
File Window summary displays the name
and type of the window as well as the nuni
ber of files and folders in the window

Your Mailbox
Your mailbox contains all of the mail that
you have received and sent. To open your
mailbox (or any other item in FirstClass)
double-click on the icon.

Conference Aliases
You can create aliases of conferences you
are interested in by selecting the original
and choosing Make Alias from the
Conference menu, 'litis puts a copy of the
conference icon on your desktop for easy
access. It also displays the unread Mag when
there are unread items.

rtrvs

m
Conference

FirstClass News

Spool]! Areas

Ir2]p
Hvi..v- J

Conferences

Special Areas

Usina SoftArc Online

AtoutFirstCla

"■ L M J "
Fi-stCUss 53fl»ir» FrilCUisSujgesl*

Unread Flag
An unread flag < P ) appears l>eside your mail-
DOS or a conference if there are any items tliat
you have not read. Sole: You can turn the Hag
off by holding the Option key and clicking on
the flag. This removes the Hag from even-
message in the conference.

News
News is a special conference used for gen
eral announcements.

Conferences Folder
The conferences folder contains all of the
public access conferences set up by jour
Administrator.

Help Folder
The help folder contains helpful instruc
tions for using your FirstClass system.

Search The Search feature allows you to search the entire FirstClass system for occurrences of specified words. To use the Search fea
ture, open the folder or conference that you want to search and then choose Find from the File menu. A Search window
appears. Inter the word you wish to search for in the Search for box and check the appropriate option boxes. Click on the
Search button to start searching every file in the current window. A new window (the hit list window) opens and displays
any matching items. Double-click on an item in the hit list to open it. Selecting an item and choosing Get info from the File
menu displays exactly where the matching item was found. You can use the the Xext Message and Pretious Message buttons
(on the palette) to move through the hit list, and the Vinci Next button to highlight the next occurrence of the word within a
message.

Check this box to search all
subjects and file names for
the word.

Check this box to search all
the folders and conferences in
the current window, as well
as the files.

Check this box to search the
body of all messages and tex
files for the word.

Document Library

£> Seerch far I medem!

0"search sutiject/flte name Q Search attachment names
Q's-arch sub coifereno-s A folders Q Search 'From" name
0Search content of documents Q Search "To/CC names

10=

Cancel | [j Search... )]

U K

Check this box to search the
names of all attachments for the
word.

Check this box to search the
names in the From list for the
word.

Check this box to search all of the
names in (he To and Cc lists for
the word.



The File List
Window

F i l l B a r — — - —
The fill bar indicates that titles
are still being added to the list
When the bar reaches the title
and disappears, the list is com
pletc.

Window Type
The file list can be a confer
ence, a mailbox, or a folder.

Folders & Conferences
Fhe upper pane of any file list
window can contain additional
folders and conferences.

Message Icon —
Fhe standard message icon. A
message received via a gateway
has an icon like this: B

Attachment Icon
All messages can have one or
more files attached to them. If a
message has attachments, the
system adds an attachment icon
to the summary. See the
Attachments and File Transfer
section for details.

Unread Flag
If you have not yet read an item,
there will be an unread flag
beside its icon.

The file list window appears when you open either a conference, a folder, or your mailbox. Generally, the files arc
shown with one line of information per file. To open an item in a file list, either double-click on it or click and choose
Open from the File menu. A message that you have opened is dimmed. For example, in the screen below, the second
message has been selected and the third has been opened. Similar to the Macintosh Finder, you can also change the
viewing mode to display either icons or a sorted list. The upper pane of the window contains folders, while the lower
pane contains files. FirstClass also supports external folders that are links to CD-ROMs and hard disks.

Number of Files
The total number of files in this
list. The number of files displayed
ma>' be less if you've checked the
Display Unread Only preference.

Number of Folders
The total number of folders
and/or conferences in the
list. Folders and confer
ences always appear above
the split bar.

Title
The title of the file list win
dow is the name of the
conference or folder. The
name is also placed in the
View menu. J

Firs tClass Suggestions
Conference 274 Files 2 Folders

Apr'94 May '94

o r Robert Ng,Instant Inc!

^ "*3ni iL Davi*s,Veritec UK
"."" D Jane Witherspoon
(§)r Joan Smith
@T Joan Smith
1^3 P Norman Dealey
0r Roy W. Allan
HP Roy V. Allan

H

I K D a t a T r a n s f e r 6 / 2 9 / 9 4
2K Re: I Suggest SoftArc
3 K I S u g g e s t S o f t A r c 6 / 2 9 / 9 4

1 IK Re: AppleScript and Pov/erTalk 6/29/94
2 K R e ( 5 ) : O f fl i n e R e a d e r 6 / 2 9 / 9 4
2 K R e ( 3 ) : O f fl i n e R e a d e r 6 / 2 9 / 9 4
2 K R e : f c 2 . 5 b u g s 6 / 2 9 / 9 4
2 K R e : M y l a t e s t l i s t . . . 6 / 2 9 / 9 4
2K Editable Login Vindow Form 6/29/94

< t

E
Sender —I
Pie name of the
person who sent
the message.

Size
Size of the message
in kilobytes, includ
ing any attachments.

Subject
Fhe subject of the mes
sage. This appears blank
in an external folder.

Date
The time and date that
the message was deliv
ered.

Zoom Box
Clicking on this expands the win
dow so that you can see all of the
items or as many that will fit on
the screen. Clicking again shrinks
the window back to its original
size.

Icon View
The upper pane is an example of
viewing by icon. To change to a
sorted list, use the View menu.

Split Bar
The split bar divides the window
into two panes. The upper pane-
contains folders and conferences,
the lower pane contains messages
and files. To move the split bar.
place the mouse over the bar and
drag after the cursor changes to a
cross, like this: ^

Scroll Bar
The scroll bar functions like a typ
ical Macintosh scroll bar. You can
click in the grey area to move up
or down by one screen.

Date View
The lower pane is an example of
viewing by date. To change the
date, use the View menu.

Operations You will find that you spend most of your time in FirstClass working with file lists—either your mailbox, a confer
ence, or an external folder. There are several operations that you can perform on a file list in addition to just opening
the items in the list. These include:

Creating New Messages a I

To create a new message, choose New from the File menu. If
you are in a conference, the message is automatically
addressed to the conference. Any new messages that you cre
ate are always placed in your Mailbox. See the Addressing sec
tion for more information on addressing and sending mes
sages.

Next & Previous in Thread I -.:. I .;

All replies within FirstClass become part of a thread which
starts with the first message. The thread allows you to track
all responses to the first message. When you have either
opened or selected a message, choosing Open Thread from
the Pile menu opens the next message in the thread. You
can also use the palette to move through the messages in a
thread. Threading also works within your mailbox.

Folders & Dragging

Within your Mailbox, you can create folders to file your mail
messages. Choose New Folder from the File menu. To rename
,the folder or give it a custom icon, select il and choose Get
Info from the File menu. You can now drag messages into the
folder.

Next & Previous Unread I ♦■Il *|

When you log on to FirstClass, you generally want to read your
unread messages right away. You can quickly open unread
items by choosing Open Unread from the File menu or by using
the palette. If there are no more items with unread flags, the sys
tem notifies you with a beep.

Make Alias
If there is a particular conference you are interested in, you can
place an alias of it on your desktop. Select the conference icon
and choose Make Alias from the Conference menu. You can
then reposition the alias on your desktop for maximum conve
nience.

History g]
By choosing History from the Message menu, you can display
the history of a message. Fhe history shows when the mes
sage was composed, when it was sent and who has read it.
Tile history also indicates whether the message has any
attachments and who has downloaded them.

Rep ly f fi j
Replying to a message creates a new message with the To. Cc,
and Subject lists filled in. Click in the lower pane and com
pose your message. In a conference, the reply is addressed to
the conference only. In your mailbox, it is addressed to all
recipients of the original message.

Reply |~g]
Replying to a message creates a new message with the To, Cc.
and Subject lists filled in. Click in the lower pane and com
pose your message. In a conference, the reply is addressed to
the conference only. In your mailbox, it is addressed to all
recipients of the original message.

Forward |T~T|

Forwarding a message creates a copy of the message (includ
ing any attachments). You can address and edit the message
and add additional attachments. The history displays a record
of everyone that you forwarded the message to.

Palette and
Session Status

System Name «^—^-^—
The name of the FirstClass system that you are
connected to.

Connected Time —^^—^^—
Fhe duration of the current session.

Time Remaining ^——
The time you have remaining from your daily time-
limit. Warning: If you exceed your time limit you
will have to wait until after midnight to log on
again.

FirstClass has a floating palette that provides one-step access to common functions. To display the palette,
choose Palette from the View menu. There is also a floating session status window that displays when you
choose Session Status from the View menu.

New Message-

Forward

Sp= Session Status sBJ;
Corneoted to: Soft Arc Onlro
Connected: 00:23:19
Remaining: 12:50 32

Previous t'nread

Previous in Thread

Previous Message



The Message
Window

When you open any message in a file list, the message appears in a Message \\ indow. A message window also
appears when you create a new message. After you have opened a new message, you can perform any action avail
able from the file list or use the standard Macintosh editing commands. You can also use the threading feature to
step through all messages in the thread. If you resize the window, subsequent messages appear in the resized win
dow as you use the threading command.

Message Icon
The standard message icon. If the message ^^^
has been sent via a gateway, it has a gate- |
way message icon that looks like this: *
To use another icon, choose Get Info from the File
menu and double-click on the icon in the info win-
clow.

From
The From name is always set to the name of the
sender and cannot be changed.

IF

S u b j e c t — — — — — — — — — —
Enter the subject of the message here. If the mev
sage is a reply to another message, the subject is
entered for you automatically and prefaced by Re.
(Re: Graphics Animator 1.0. for example.) You
can change this subject.

S t y l e d T e x t »
You can change the font, style, size, and color of
text in the body by selecting the text and using
the Edit menu. If you try to display a message
which was composed in a font that you do not
have, the message appears in the system font.

Date
Iliis is the date that the message was sent.
If a message is unsent, this line will read
"Unsent."

r Title
This is the subject of
the message.

: [ j e - firnphirs Rnimntnr 1.0

Wednesday, October 28. 1994 1045:01 AM
Customer Support Item

From: l «n MacLean
Subject: Graphics Animator 1.0
To : C u s t o m e r S u p p o r t
C c : S u s a n C h e e

in-.nL :nn .
Graphics Animator 1.0
This newscftware package, which is completely compatible win our
XOX 3D Graphics package, can be used to animate your graphics
presentations. It has many features. Including support for prinrto vkiw.

Graphics Animator is $795. Existing registered users cf SDgraphxs
may purchase Animalor for the lowprlce cf $395, a savings of $400.

Ian Vac Lean
GmpfjksAnirmlKV Product Ma nager
XOX Software Inc.

r~

Postmark
After you semi a message, the system places a post
mark in the upper right-hand corner.

Envelope
This is the envelope of the message. It contains
addressing information, the list of attachments, the
postmark, and the date and time the message was
sent. If the message is a form (for example, a phone
message form), the- envelope contains the form
information

L
1_

Split Bar
Fhe split bar divides the message window into two
panes: the em elope and the message body. Fjch
pane can be scrolled with its own scroll bar.

Message Body
This is the body of the message. To enter text in an
unsent message, click in the body and type. Note:
You cannot change text in the body of a sent mes
sage.

Addressing When you read a message, the To and Cc fields list the individuals and conferences to which the message was sent.
When you create a new message, you fill in the To and Cc fields with the names of the people or conferences who arc-
to receive the message. The system then searches its user director)' for the names that you have entered. To fill in the
addresses, just click in the To or Cc field and enter a name. You don't have to worn' about capital letters, and you you
don't even have to enter the whole name, just enough to help in the search. Here is an example:

r Resumes
Double-clicking on a name in a To, Cc, or From list; in a directo
ry window; in a chat; or in a history window displays the
resume for that user. You can edit your own resume by choos
ing Resume" from the Edit menu.

My Rusuiiiij

? Roy W.Allen
I am tte essistant manage1" of Venice's Customer Support department

On a good day, yau can probably reach tre at ext 2413; but I am far
more likely lo pay attention to a well-v/ntten piece of e-mail II

:>i i-
Thc top portion of the resume form contains a field into
which you can paste a picture of any size, and a title field into
which you can enter your name. The bottom portion of the
form is edited like a standard message.

Click in the To Field, enter the name of the
user or conference you want to send to, and
press the Return key.

To: joan smV,
Cc:

FirstClass searches for the closest match and
places it back into the field.

To: Joon Smith
Cc:

If the name you enter matches more than one-
user, a window containing all matching names
appears.

To: Joan Smith
Cc: roy|

In this example, the matches include all users
and conferences which contain a name or a
word beginning with the characters "roy."

.:;[ j: fl i i 'R r tn ry

Roy Graari
| Roy Hil l
\ Jean-Pierre Roy

■q- Tte Royal Fcmily

l-T

Highlight the name you want and press the
Select button. (You can select multiple names
by shift-clicking ) Hie system places the select
ed name back into the envelope.

To: Joan Smith
Cc: Roy Brown

Roy Schulze
Gillian Royce

Chat The Chat feature allows you to have real-time conversations with multiple users. To start a private chat, choose
Private Chat from the Service menu. To enter a public chat, double-click on the chat's icon.

I n p u t B o x « ^ — —
Fntcr your chat messages here. To
send the message, press the Return
key or press the Send button.

Participants list
A list of participants in chat. Double
click on a name for the user's resume.

Chat Transcript
The chat text appears here as the partic
ipants enter their messages. You will
also receive notification when people-
enter and leave the chat. Choose Save
from the File menu to save a copy of
the transcript.

IDE Private Cha is :
11 Ijst wanted to know If you have reviewed M ry's report yet. We have to

jpressnt It at the stuff meeting, tomorrow)

ip^iits: Brian Vetch' Ma'y Morganste

Calhy Westlock

D Scrol l Look Q'souni;

3C
Mary Morgans tern: Do you hive a copy of the report I sen- you?

an Velch: I sent it to Cathu. Let me just invite her into tl :> chat.
Cathy Vest look has joined the ohjt.
Cathy Vest lock: What's up?

•■:.-

Scroll Lock
Messages sometimes arrive too fast to
read them all. Check this box to stop
scrolling when new lines are received
so old messages can be reviewed.

Sounds
Check this box to hear sounds when
new chat messages are delivered and
when a user enters or leaves the chat.

Invite Button
To invite other users into the chat,
click on the Invite button. Select the
names of the users you wish to invite
and press the Select button.



Attachments and File
Transfer

FirstClass allows you to transfer or share files with other users using the attachment feature.
When you compose a message, you can attach any file stored in your computer to the mes
sage. You then send the message as usual. When you read a message with attachments, you
can transfer any of the attachments to your computer. A powerful feature of FirstClass is that
attachments work well with both private mail and conferences. This means that you can eas
ily distribute files to large numbers of users.

2.5 Upgrade Files E:
Tuesday, June 28,1994 1:45:58 PM
Customer Support Itsm

From: Deborah Bra t in
Subject: 2.0 Upgrade Hies
To : C u s t o m e r S u p p o r t
Attachments: <& 2.5 L'pgrede.sea

Downloading file: 2 3 Upgrade sea
File Size: 133433 Transferred: 66717

Downloading
If a message has any files attached, the attachments are listed in the envelope after the To
and Cc lists.

To transfer, or download, an attachment from the FirstClass server to your computer, select
the attachment and then choose Save Attachment from the Message menu (or just double
click on it). This brings up a dialog box that allows you select where on your computer you
want the file saved.

Once you have selected the location, click on the Save button. The system transfers the file
from the FirstClass server to your computer. Note: The time required for the transfer varies
depending on lite size of the file and the speed of your connection.

As the system transfers the file, the File Transfer Progress window appears. You can contin
ue to use all of the features of FirstClass even while a file transfer is in progress. To cancel a
transfer, close the progress window. If you cancel a file transfer before it is finished, you can
restart the transfer by downloading to the same location on your computer and choosing
Replace. Only the remaining data will be transferred.

If the attachment is a picture, text file, or sound you can view it (or hear it) online by select
ing it, holding down the Option key, and choosing View Attachment from the Message
menu (or just holding down the Option key and double-clicking on it). The attachment
appears in a new window. You can then choose Save to save the attachment on your com
puter.

|€3 Reports Folder ▼ |

P Hpnl Status
Q February Status

Interim Status Report

QJanua ry S ta tus
Q March Status
Q Mny Status

en Sys tem

[ E j e t l ]

1 I lesktop~]

Cancel

Upen

File Transfer Progress
Uploading file Interim States Rexrt
File Size: 1612SO Transferred 53760

Uploading
To send a file to another user or a conference, compose a new message as usual. To add an
attachment to the unsent message, choose Attach File from the Message menu. You will be
prompted to select the file that you want to attach. Select the file you want to attach and
then click the Open button to transfer, or upload, the file from your computer to the server.
The time required for the transfer will vary depending on the size of the file and the speed of
your connection.

While the file is being transferred, the File Transfer Progress window is displayed. You can
continue to use all of the features of FirstClass even while the file transfer is in progress.
When the transfer completes, the attachment will be listed in the envelope of the message.
You can attach as many files as you wish. If you make a mistake, you can delete an attach
ment by selecting it anil then pressing the Delete key.

Reuised Repurt mj:
Unsent Message

F r o m : Ta n y a K e e n
Sabject: Revi«ed Repot
To : G i l l i a n R o y c c

Attachments: f?] Interim Stalin Report

liereislhe latest copy of the report I have revi;ed figure! one. and two ;n that they
are more readable Please get back to me vith your comments

Tanysj
^TT—

If you are sending attachments that will be downloaded by users logged on with modems, or
if you are using a modem, you should consider using a compression utility such as
Compactor™, Stuffit™, or DiskDoubler™. Compressing files allow them to be sent faster,
thereby reducing the duration of your phone calls. They also use up less storage space on
the server.

If a file is only partially uploaded or downloaded, it will have a partial transfer icon ( P>). To
continue from the point the transfer stopped, restart the transfer and choose replace when
prompted.

This document copyright © 199-1 SoftArc Inc. 100 Allstate Parkway. Markham, Ontario. Canada I.3R ol 13 Phone (905) •» 15-7000 Fax (90'S) 115-7151
litis document can be reproduced in part or in whole by any registered owner of the FirstClass product from SoftArc providing this copyright mark is left intact. A complete user
manual is also available. FirstClass and the FirstClass Logo are registered trademarks of SoftArc Inc. Macintosh is a trademark of Apple Computer Inc. Other products mentioned in
this document may be trademarks or registered trademarks of their respective companies and arc- hereby acknowledged.



GOOD DEALS #19
by Ken Slingsby

This is another installment in a series of articles which list good deals and press releases that have been brought
to our attention via a news source established by Apple Computer Co, AppleLink. Due to the constraints of space
in our newsletter and time available, the articles have been greatly condensed. All were posted in their entirety on
the Club's BBS. To read the full articles, plead or beg a friend who has access to the BBS to copy it for you.

As an aid in your review of the articles, I have divided them somewhat arbitrarily into DEALS and PRESS
RELEASES. The DEALS include price, dates available, and the address of the vendor. Most of the DEALS are special
limited time offers with a significant price reduction. They are presented here as a service of Mini'app'les. The
PRESS RELEASES are to make you aware of the new products. You may have to hunt to find a dealer that supports
the product.

Mini'app'les makes no claim as to the usefulness or quality of the products offered herein. The User Group does
not endorse the products and is not supporting the products. The following is not paid advertisement. There may
be other products mentioned on AppleLink not appearing here. If so, that is an omission, not a refusal of the prod
uct. As in all purchases, buyer beware!

Please remember that the Good Deals bargains may be limited in quantity. The seller may not have any prod
uct in stock by the time this article is printed.

Products and names mentioned in this document are trademarks of the respective companies. Some of the fol
lowing is Copyright (c) 1995, User Group Connection. All Rights Reserved. Apple-Authorized User Groups may
redistribute this information to their members (or use it to recruit them) at meetings, in newsletters, by fax, or bul
letin board systems.

DEALS
Date: February 24,1995
To: User Group Friends
From: Sherri Jackson
Subject: March User Group Member
Purchase Program (UGMPP)

The UGMPP keeps growing and
changing. Not only have we been
able to offer the IN CONTROL
3.0/Quicken 5 bundle for the last
couple of months, but now we have
come up with a few CD-ROM's at
great prices. We will continue trying
to get more suppliers involved in the
UGMPP.

One of the changes to the pro
gram that may not be as obvious is
the fact that UGC is now conducting
a QUALITY CONTROL CHECK on
every refurbished product before it
leaves our warehouse. That means
we will open every box, verify condi
tion and configuration, and repack
age the unit if necessary.

UGC will continue to strive for a
bigger and better Purchase Program
for the User Group community.

Thanks for you continued sup
port!

Performa 476
Bring High Performance Home!- Fast 68040 Processor
- PowerPC Upgradable!
Ready to retire your old Mac? Sell

it and move up to this powerful sys
tem. The Apple Macintosh Performa
476 is equivalent to a Quadra 605
with a big hard rive (230MB). It
offers power and versatility that's
easy to use and learn but hard to
outgrow. Add a CD-ROM drive and,
with built in digital sound, you'll be
multimedia ready. When you add a
printer, scanner and other SCSI
devices there's no need to buy or
install separate expansion cards!
Bring high-performance color com
puting home to your family or your
home business!

> Factory Refurbished with 90-
day wananty.

> Includes: 68040 @ 25-Mhz
Motorola Processor; 4MB RAM;
230MB hard drive; standard Apple
keyboard; Apple Desktop Bus Mouse;
built-in speaker; microphone;
ClarisWorks, At Ease and System 7.1
pre-installed.

> Does not include: monitor,
modem or original software bundle.

$699

Includes ground shipping. For
next day FedEx add $15. Earns 1,500
points for your group. Available in
early March
Performa 550

All-in-One Multimedia Machine!
- Built-in CD-ROM Drive
- Faster than an LCIII
- PowerPC Upgradable!
The Apple Macintosh Performa

550 computer features a fast
Motorola 68030 microprocessor, a
brilliant 14-inch Trinitron RGB color
display, and sophisticated built-in
multimedia features. All the hard
ware and software you need to get
started is included. Just take it out of
the box, plug it in, and turn it on.

In addition to the standard 160-
megabyte hard disk drive and 1.44-
megabyte SuperDrive floppy disk,
the Macintosh Performa 550 is
equipped with a built-in double-
speed CD-ROM drive, so you can tap
into a growing selection of CD-based
titles. High-quality stereo sound is
provided by front-mounted speakers,
and the integrated microphone
allows you to add sound to many
Macintosh applications.

> Factory refurbished with 90-day
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Apple warranty
> Includes: 68030 @ 33-Mhz

Motorola Processor; 5 MB RAM
(expandable to 32 MB); 160 MB hard
drive; double-speed internal CD-
ROM drive; 14" Sony Trinitron color
RGB monitor; standard Apple key
board; desktop bus mouse; built-in
stereo speakers; microphone;
ClarisWorks, At Ease and System 7.1
pre-installed.

> Does not include: modem or
original software bundle.

$849.00
Includes ground shipping. For

next day FedEx add $30. Earns 1,700
points for your group. Available in
early March.
Performa 578

Everything You Need, With
Room for More!

- 8MB RAM / 320MB Hard Drive
- Double-speed CD-ROM Drive
- Built in Stereo Speakers
The Macintosh Performa 578 fea

tures a fast 33-megahertz 68LC040
Motorola microprocessor and comes
with everything you need built into
a single unit. With 8 Megs of RAM
and a 320 Meg hard drive you can
run every application with room to
spare!

Need more? This unit can be
expanded to 32 Megs of RAM and
multiple ports allow you to easily
add peripheral devices, such as exter
nal disk drives or scanners. A flexible
communications slot allows future
connection of a high-speed 14.4-
Kbaud fax modem.

In addition to the standard 1.4-
megabyte Apple SuperDrive floppy
disk drive, the Macintosh Performa
578 is equipped with a double-speed,
tray loading internal CD-ROM drive.
The built-in, 14-inch Sony Trinitron
color display delivers unmatched
image resolution and clarity in thou
sands of colors.

> Factory refurbished with 90-day
Apple warranty.

> Includes: 68040 @ 32-Mhz
Motorola Processor; 8 MB RAM
(expandable to 32 MB); 320 MB Hard
Drive; Double-speed internal CD-
ROM drive; 14-in. Sony Trinitron

color RGB monitor; Standard Apple
keyboard; Desktop Bus Mouse II;
built-in stereo speakers; microphone;
ClarisWorks, At Ease, Macintosh PC
Exchange, and System 7.1 pre-
installed.

> Does not include: modem or
original software bundle.

$1,279.00
Includes ground shipping. For

next-day FedEx add $30.00. Earns
4,000 points for your group.
Available in early March.

StyleWriter II

Plug and Play Simplicity With
Any Macintosh Computer- Very Affordable

- Award-winning
- 360 dpi Ink-jet Printer
The Apple StyleWriter II printer is

your most affordable path to quality
printing. Weighing only 6.6 pounds,
the StyleWriter II is a snap to move
between locations. It supports
TrueType™ fonts to produce sharp
text at any size. And with GrayShare
software you can share it among
multiple users and print in gray
scale. Winner, Macworld magazine
World Class Award, September,
1994.

> Factory refurbished with 90-day
Apple warranty.

$189.00
Includes ground shipping. For

next day FedEx add $15. Earns 500
points for your group. Available in
early March.
.29 Monitor

Apple Performa Plus Display
-14" RGB Monitor
- 0.29 mm dot pitch
- 640 x 480 pixels
- Noninterlaced
- Meets the Strictest International

Magnetic Field Emissions Guidelines
(SWEDAC MPR 2)

> Factory refurbished with 90-day
warranty.

$169
Includes ground shipping. For

next day FedEx add $25. Earns 500
points for your Group. Available in
early March.

In Control 3.0 and Quicken 5

The Perfect Software Bundle to
Keep Organized

In Control helps you get com
pletely organized, right away, in
your own way, combining the flexi
bility of an outline manager with the
structure of a multi-column database
and the convenience of a calendar,
all linked together. Combine views
and drag and drop items anywhere
you want. Remember important
events with the included reminder
extension. Look up phone numbers
from your contact databases. Link to
any document. What do you do
with it? Plan a wedding. Prepare a
shopping list. Run a User Group.
Several example templates are
included.

Quicken 5 organizes your
finances quickly and easily. It looks
like your paper checkbook, but links
accounts, prepares budgets and
reports, prints checks and makes
electronic payments. Use it for plan
ning, investing, credit card tracking,
and exporting your data to a tax pro
gram. New in version 5: Financial
Calendar eliminates data entry and
provides an overview of your
finances. Net worth forecasting, tax
tips and more.

$49.95 + $5 for FedEx shipping.
NEW, Full current versions.Eams 100
points for your Group. In stock now.
ASSORTED CD-ROM TITLES

ALL PRODUCTS IN STOCK
EACH CD-ROM DISC PUR

CHASED EARNS 50 POINTS FOR
YOUR GROUP Prices do not include
shipping, add $3 for FedEx overnight
shipping.
Info-Mac IV — $39.95 (+$3 shipping)

Info-Mac has 10,000 programs
from Stanford University's Sumex-
Aim Info-Mac Archive. The Info-Mac
is one of the Internet's most com
plete and up-to-date collection of
Macintosh Software. This disc is jam-
packed with graphics, sounds,
HyperCard stacks, games, virus detec
tion programs, commercial demos
and more.
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Ultra Mac-Games — $29.95 (+$3
shipping)

This is THE largest collection of
Apple Macintosh games. It's super
easy to have fun, because all games
are ready to run directly from the
CDROM! The disc features 524.5MBs
of games, from early classics to the
newest shareware including: arcade
games, card games, text and graphic
adventures, puzzles, work games,
and war games. You will also find
the latest commercial demos, hints,
cheats, walk throughs, and maps for
many poplar games. Bonus selection
includes Virtual Reality and Newton
files.

To make every game really easy
to find, the disc is fully indexed in a
ClarisWorks database. You'll have
hours of pure fun with the Ultra-Mac
Games CDROM!
Internet Info — $29.95 (+$3 shipping)

The Internet Info CDROM con
tains a sample of the wealth of infor
mation that is available on the
Internet. The Internet is the comput
er network linking thousands of uni
versities, research labs, and high
technology companies all over the
world. You might know the Internet
as the new "Information Highway."

You get 12,000 documents about
computers and networks: Answers to
frequently asked questions (FAQs);
Internet RFCs and IENs; Computer
security documents; Internet net
work maps; Usenet technical discus
sion archives; FTP site lists and
descriptions of the archives they
hold; Extensive bibliographies and
technical book reviews; Documents
and standards from IEEE, ISO, NIST,
ANSI and others. If computers, net
working and technology interest
you, order this CDROM today.
Fractal Frenzy — $29.95 (+$3 ship
ping)

The Fractal Frenzy CD ROM con
tains examples of all the major frac
tal types: Mandelbrot, Zexpe, barns-
ley, fn(z)+fn(pix), etc. You'll be
enthralled by the images on this
disc.

Garbo — $19.95 (+$3 shipping)
This CDROM contains 337

megabytes, 3598 files for PC's, and
135 megabytes, 1989 files for
Macintosh computers ranging from
games to utilities.
Gifs Galore — $29.95 (+$3 shipping)

The GIFs Galore disc has 5,000
images in 44 categories, from ani
mals to Vietnam and almost every
thing in between. All art is in the
importable GIF format, most in full
color, and all are royalty free.
Project Gutenberg — $29.95
(+$3 shipping)

This CDROM contains a collec
tion of public domain English lan
guage literature and historical docu
ments from the Project Gutenberg at
the University of Illinois, Urbana.
This collection represents some of
the most commonly used and refer
enced works of literature. All the files
are in plain ASCII format, which
makes this collection accessible to
virtually any computer. Simply use
your favorite word processor or text
editor to open any of the files in this
collection.

Space & Astronomy — $29.95
(+$3 shipping)

The Space and Astronomy
CDROM is a collection of 1,000
image files (most are from NASA)
and 5,000 text files, and software
relating to space exploration and
astronomy.
Travel Adventure — $29.95
(+$3 shipping)

This disc contains a first-rate col
lection of travel photos of the United
States, Ireland, Austria, Germany and
the Caribbean Islands. All images are
royalty free, so you can reprint them
without additional charge.
USER GROUP MEMBER PURCHASE
PROGRAM POLICIES:

- 30-day, no-questions-asked,
money-back guarantee.- In-stock products shipped next
day for orders received by noon PST.- Refurbished products carry a 90-

day Apple warranty and include UPS
ground shipping with next-day
FedEx available at additional cost.

- We cannot guarantee ship date
for products not currently in stock.

- Visa, MasterCard, American
Express, Discover card or cashier's
check accepted.

- Orders paid by cashier's check
subject to cancellation if check not
received within 10 days.

- Only members of Apple
Authorized User Groups in the U.S.
may participate.

- Limit: two of any item per
member.

- Not responsible for e-mail
delays or typos. Please verify current
prices with a UGC Customer Service
Representative.- Orders will be filled in the order
received while supplies last.

To order or for more information,
call (800) 350-4842.

Please tell your members so they
get the news directly:

To subscribe to UGC's automatic
mailing list from any online service
that supports Internet e-mail: Send a
message to:
LISTSERV@dolphin.csudh.edu. Leave
out the subject. On a line by itself in
the message type: SUBSCRIBE UGC-
MAC-L first name last name (substi
tuting your own name). You will
receive an automated response.

PRESSRELEASES
Apple Mobile Message System

CUPERTINO, California—January
3,1995—Apple Computer, Inc.
today introduced a new product that
aims to simplify the complexities of
wireless communications by bring
ing together in a single package the
technologies necessary to help
mobile computing professionals stay
in touch. Called the Apple Mobile
Message System, it is a wireless mes
saging solution that allows users of
notebook computers and PDAs to
receive short and long wireless mes
sages, calendar updates, news
updates, and a variety of other infor-
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mation via a nationwide paging net
work.

The all-in-one-box solution inte
grates the hardware, software, and
services necessary to send and wire-
lessly receive messages with a PCM
CIA-equipped Apple PowerBook or
Windows-compatible notebook com
puter, or a Newton MessagePad. The
integrated package combines prod
ucts and technologies from Apple
and other industry-leading vendors.
It includes the Apple Notification
Service, a "one-stop" activation,
billing, and support program; a
PageCard wireless message receiver
with LCD screen from Socket
Communications; Update! receive
software and Notify! send software
from Ex Machina; DateBook &
TouchBase Pro Bundle software from
Adobe Systems; message transmis
sion via the PageNet nationwide
wireless network; and wireless gate
way services by The National
Dispatch Center, Inc.

The Apple Mobile Message
System allows clients, colleagues,
and friends to reach mobile users
when they're away from the office
through a variety of methods.
Through a personal 800 message
center number, users can receive text
messages, numeric pages, and notifi
cation of voice mail and faxes
received. Alternatively, users can
receive text messages sent via
modem, or via the Internet. Apple
Mobile Message System users will be
assigned a personal 800 number,
toll-free message center, and central
toll-free fax mailbox when they first
activate the product through the
Apple Notification Service.

The Apple Notification Service
also gives users the option of getting
updates on the day's news, sports
and weather (expected to be avail
able in March), delivered straight to
the Socket PageCard. The service can
also transmit up-to-the-minute
reports on the performance of stocks
by sending quotes directly to the
PageCard.

All of the different methods of
notification and types of messages
are relayed to the PageCard, where

users can read the messages on its
LCD screen. Or the PageCard can be
inserted into the PCMCIA expansion
slot of a PowerBook, Newton
MessagePad, or Windows- compati
ble notebook computer, where mes
sages can be viewed, stored, or trans
ferred into applications.
New Release of MPW Pro and E.T.O

Cupertino, California—February
1,1995—Apple's commitment to
providing key Macintosh develop
ment tools for improving program
mer productivity and facilitating the
creation of high performance appli
cations was reinforced today by the
shipment of the most recent releases
(Release 16) of the company's MPW
Pro and E.T.O.:
Essentials*Tools*Objects products to
developers.

Major new software releases
included in Release 16 of both MPW
Pro and E.T.O. are:

— The first beta release of MrC
and MrCpp, new C and C++ compil
ers for developing native Power
Macintosh applications.

— An alpha release of the
PPCLink, the MPW-based linker for
development of native Power
Macintosh applications. This version
is a native tool and is considerably
faster than before.

— Version 1.1 (final) of PPCAsm,
the PowerPC assembler. This assem
bler now supports symbolic
debugging.

— A beta release of MPW p2c, an
Object Pascal to C/C++ source code
translation system. This handy tool
facilitates the translation of proce
dural or object-oriented Pascal code
into C and C++ code.

— Version 3.1.2 (final) of
MacApp, the leading Macintosh
application framework for creating
680x0-based Macintosh applications
and native Power Macintosh applica
tions.

— Version 2.0.1 (final) of Ad Lib,
a powerful user-interface editing tool
for building views for the MacApp
3.x application framework.

— An alpha release of the Code
Fragment Manager (CFM) runtime

software for 680x0-based Macintosh
systems. CFM-68K supports the
development of shared libraries and
drop-in code modules for 680x0-
based applications using program
ming techniques similar to those
used today for development of
native Power Macintosh applica
tions.

— An alpha release of the System
Object Model (SOM) runtime soft
ware. SOM is an object-oriented pro
gramming technology for building,
packaging, and manipulating binary
class libraries.

MPW Pro, priced at U.S. $495, is
provided on a CD-ROM and comes
with a development environment,
compilers (C, C++, Assembler),
debuggers, and testing tools for
development of 680x0- and
PowerPC-based Macintosh systems.
It also includes three introductory
tutorial manuals and complete elec
tronic documentation. Updates from
previous versions of MPW Pro are
U.S. $195. Upgrades from older
MPW-based products (MPW
Development System, MPW
Development Environment, or
Macintosh on RISC SDK) are U.S. $295.

E.T.O., priced at U.S. $1,095, is
sold as a 3-issue-per-year CD- ROM-
based subscription. Subscription
renewals are U.S. $400 per year.
E.T.O. includes all the MPW Pro soft
ware as well as Symantec C++ for
Macintosh from Symantec
Corporation, an electronic version of
the Inside Macintosh programming
reference, and a complete suite of 25
printed reference manuals.

Both MPW Pro and E.T.O. are
available immediately through
APDA, Apple's source for develop
ment tools and related programming
products. APDA publishes the APDA
Tools Catalog which describes hun
dreds of Apple and third-party prod
ucts. Developers should contact
APDA using the following address or
phone numbers.

APDA, Apple Computer, Inc.,
P.O. Box 319, Buffalo, NY 14207-
0319, 800-282-2732 (U.S.A.), 800-
637-0029 (Canada), 716-871-6555
(International), 716-871-6511 (Fax)
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Apple MessagePad 120 Released
CUPERTINO, California—January

30, 1995—In a further refinement of
its Newton OS-based products, Apple
Computer, Inc. today announced
the Apple MessagePad 120, featuring
one and two megabyte (MB) models,
improved industrial design and
screen clarity as well as a variety of
new applications from third party
developers and StarCore, Apple's
Newton software publishing and dis
tribution arm.

Additionally, as part of the com
pany's strategy to provide its cus
tomers with robust, up-to-date sys
tem software, Apple announced
today a system update for Apple
MessagePad 100 and 110 owners in
the U.S.

Based on extensive customer
feedback, the MessagePad 120 will be
available in a 1MB and 2MB configu
ration, with the 2MB model provid
ing users with nearly triple the user
storage space as compared to the
MessagePad 110. This additional
memory can be used to store more
custom and third party software in
the product's internal memory, thus
freeing up the PCMCIA slot for add
on communications products and
peripherals. Both the 1MB and 2MB
versions of the MessagePad 120 have
improved features over the earlier
models. Industrial design improve
ments include a removable lid,
improved screen visibility, and a
PCMCIA lock located on the side,
allowing for fast and easy removal of
PCMCIA cards when the lid is folded

back.
The MessagePad 120 comes bun

dled with the following products at
no extra charge:

— Notion: The Newton List
Manager. A personal manager for
mobile professionals, Notion makes
it easy to create and manage lists,
juggle complex tasks and manage
projects more effectively.

In addition, the 2MB configura
tion comes with:

— Pocket Quicken for Newton:
The market-leading, mobile finance
software by Intuit, designed specifi
cally for Newton OS- based products,
makes tracking personal and busi
ness finances while on the road, fast
and easy. Pocket Quicken enables
users to enter data once at the point
of transaction, thus saving time and
improving accuracy. Pocket Quicken
can be used as a standalone personal
finance manager or as a data capture
device that can seamlessly communi
cate with desktop Quicken on a
Windows- or Mac OS-based personal
computer. A coupon for a comple
mentary copy is included;

— eWorld: Apple's newest online
service. Using NewtonMail, the elec
tronic mail system for the
MessagePad, users can connect to
eWorld and exchange e-mail with
subscribers of many online services
including CompuServe, AppleLink,
America Online and Internet. A
coupon valid for a complementary
month of eWorld service is included;

— An external data/fax modem
(2400/9600 bits per second [bps]):

Stay in touch anytime, anywhere
with the MessagePad 120. Users can
fax documents, send and receive e-
mail messages and retrieve informa
tion from online bulletin boards;

— PowerNeWS: A news service
from Pen Tekk Software for Newton
OS-based products that enables
MessagePad users to keep abreast of
the news with personalized reports
tailored to their specific needs and
interests. A coupon for a comple
mentary month of service is includ
ed.

The Apple Message Pad 120 with
a 1MB configuration is Apple priced
at US$599 and the 2MB configura
tion is US$699.

Two versions of the system
update are available, version 1.3
(414313) for MessagePad 100 users,
and version 1.3 (345025) for
MessagePad 110 users. Among the
software enhancements, the upgrade
increases the reliability of erasing
PCMCIA flash cards and improves
the product's ability to remember
user preferences. Notification win
dows, such as alarms, now remain
open when the MessagePad goes to
sleep, allowing users to receive noti
fication even when the Newton is
unattended for a period of time and
the '*' and '#' characters may now be
used when dialing phone numbers
from the call slip. For example, users
may set the dialing prefix to '*70' to
turn off call waiting, if their phone
system allows it.

Mini'app'les Board of Director's meeting minutes
February 2,1995
Matthews Center, Minneapolis
Submitted by Roy Sorenson

Attendance

Members: Greg Carlson, Brian
Bantz, Jacque Gay, Roy Sorenson,
Erik L. Knopp, Steve Thompson, Les
Anderson, Bob Demeules, Owen
Aaland. Absent: David Laden, Eric
Jacobson. Guests: Bruce Thompson,
Dick Peterson, Tom Gates.

January meeting minutes were

accepted.
Treasurer's Report
by Jacque Gay:

January showed a profit of
$579.35! This reflecting many new
memberships and the lower newslet
ter cost. Jacque still hasn't received
receipts from Brian for the swap
meet: Brian said he will get this
straightened out. A check mailed to
the printer is missing, Steve will
check with editor John Hunkins, Jr.

to try to track it down.
President's Report
by Greg Carlson:

No report.
Vice President's Report
by Brian Bantz:

General meeting date and loca
tion will be posted when finalized.
Brian is trying to get speaker confir
mation from modem maker
MultiTech, and authors Michael
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Fraase and Douglas Clapp. Brian
attended MacWorld and got many
ideas for fundraising, including raf
fles and taking donations for SIG
meetings.
Membership Director's Report
by Bob Demeules:

Seven new members in Jan., 30
renewing members, for total mem
bership of 355.
Software Report
by Owen Aaland:

$58 in Jan. EDOM sales. Bruce
Thompson said as Mac file sizes
increase, use of HD disks becomes
necessary: those programs generally
require newer machines that have
HD disk drives. Bruce said he will
start categorizing the EDOMs.
Publications Director's Report
by Steve Thompson:

Steve applied stickers to all the
Feb. newsletters to announce a late
SIG location change: the board gave
Steve a round of applause. Steve will
contact MUG news service to get the
MUG disk sent to the club. Sysop
Dick Peterson said we have permis
sion to print a First Class BBS user

guide in our newsletter.
Mac SIG Director's Report
by Eric Jacobson:

Absent—no report.

Apple II SIG Director's Report
by Les Anderson:

Meetings continue, no news to
report.
Operations & Resources Director's
Report
by Erik Knopp:

Erik has info on how to change
the Voice Mail message.

All reports approved.
Old Business

LCD viewer replacement: info
received from a California UG that
has a 3 year old Proxima viewer for
sale, which runs both PC and Mac in
16 colors. Motion by Les, seconded
by Brian authorizing Greg to negoti
ate purchase price up to $850.Voting
yes were Jacque, Roy, Les, Erik, Bob,
Brian and Owen; voting no was
Steve — motion approved.

Greg still needs to pick up club
Apple II equipment from Chuck
Theisfeld.

New Business
Midwinter Madness Sale: Blaine,

Feb. 11, table cost $15. Motion to
reserve table passed without dissent,
Tom Gates volunteered to organize
staffing.

Nomination Committee: Bob,
Bruce, Les, and Denis Diekoff will
form a nomination committee.

Spring Swap Meet:
Will shoot for May 6. Tom Gates

will check with Apache, Brian will
see if TC/PC wants to participate.

Bob suggested adoption of bylaw
change to allow board meeting min
utes to be published on the BBS
instead of in newsletter: no action
taken.

Adjournment:
No Feb. executive board meeting.

Next board meeting 7 pm, Thursday,
March 2, Matthews Center, 2318
29th Ave. S., Minneapolis.
Submitted by Roy Sorenson, secretary.
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(Continued from page 12)
fight the alien invasion by giving
you maps of the area and supplying
intelligence on the several species of
aliens. If you are a fan of good sci
ence fiction, Marathon's twisting
storyline will certainly please.

The variety of the game play is
incredible for a product that ships on
four floppies. The six different guns,
ten different aliens, and thousands
of different rooms will leave your
head spinning. It is by no means an
easy game: the boards can be long
and complex, and the aliens will
pound you quickly and often.
However, the thrill of exploring each
new board, coupled with the fear of
unknown dangers, is really unlike
any game I have played before.
Never before have I cried out in fear
while playing a game, but that is just

what I did when a red-cloaked
Compiler appeared from nowhere,
spreading its arms and shooting me
down.

Beyond the solo game, however,
exists an entirely other experience.
Marathon supports network play
with up to 8 participants and has 10
unique levels for network games.
Running around battling seven other
people is an even more engaging
experience than the real game. Being
lucky enough to have a couple of
Power Macs at my house, I can tell
you it is a unique and powerful feel
ing to toast your roommate with a
missile launcher. After each round,
you are presented with a "Carnage
Report" that graphs the performance
of the participants and a DPM, or
Deaths Per Minute ratio. If you have
access to networked Macs, and won't

get fired or kicked out for playing,
you'll have no reason not to play, for
each copy of Marathon comes with
two serial numbers for instant net
work carnage.

There are a hundred little details
that make Marathon such an incred
ible experience. Every bullet hits
something, be it an alien, a colonist,
or a wall a hundred feet away, you
see the impact point or ricochet.
Dark rooms are lit by the flash of
guns. Through windows you see the
alien's ship lurking ominously in
space, floating in a bed of 3D stars.
Aliens fight each other when one
accidentally shoots another. Stereo
sound imaging places sounds in the
direction of the sound's creator, be it
the battle cry of aliens, or the
screams of the dying. Dead bodies lie

(Continued on page 27)
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M i n i ' a p p ' l e s H a n d y F o r m
Name:
Address:
Company:
City, State, Zip:
Phone (Home):
Occupation:

.(Work):

Member ID#(if applicable): Expiration date:

If this is a change of
address notice, please

afix your current mailing
label here, or provide the
corresponding informa
tion. Be sure you have

written your new address
on the lines above.

ID#:

Name:

Exp. Date:

Street:

City, State, Zip:

New and Renewing Members
specify your level of support
□ Individual $25.00
□ S tudent * $15 .00
□ Sustaining $40.00
□ F o r e i g n $ 4 0 . 0 0
□ Educational $50.00
□ Corporate $100.00

*Must be a Full-time student
of an accredited institution.

Make Checks
Payable to

"Mini'app'les"

Which personal computer(s) do you use?
□ Power Macintosh model(s)
J Macintosh model(s)
J Apple II model(s) .
□ Other

If this is a new
membership, or a

renewal, please
take a few minutes

to fill out the
questioniare.

What attachments or
peripherals do you use?
G QuickDraw printer
-l PostScript printer
Zi Modem
J Scanner/digital camera
j Drawing tablet
□ Voice mail
□ MIDI
□ Other

What are your areas of special
interest?
j Business applications
J Household applications
J Educational applications
J Desktop Publishing
J Programming
j Networking
□ Games
□ Other

_J Check if you want your name
withheld from commercial and
other non-club mailing lists

J Check if you are interested in
volunteer opportunities (see
other side)

j Check if you were referred by
a club member. Please give
name

eDom Orders
Prices:
5.25" eDom:
5.25" System:
3.5" eDom:
3.5" System:

$3.00
$1.00
$5.00
$3.00

Mac System 7(9 disks): $15.00
GS/OS 6.0.1 (6 disks): $10.00
(Prices include 6.5% Minnesota sales tax)

Disk size eDom Title or Description

Current Apple System Software
V e r s i o n D a t e F o r m a t

Apple II, 11+, lie, lie
Dos 3.3 System Master n/a 09/10/85 5.25"
Apple II System Disk

(128K required) 4.02 05/06/93 5.25/3.5"
ProDOS Users Disk

(64K machines) W/ProDOS 1.9 02/05/85 5.25/3.5"
Apple IIGS
GS/OS System (6 disks) 6.0 4/92 3.5"
HyperMover(2disks) n/a n/a 3.5"

Qty. Price

Total merchandise

Double price for non-members

Add $1/disk shipping ($4.00 max)

Total

Make checks
payable to

"Mini'app'les"

Grand
Total:
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Attention:
□ Membership Director
□ Software Director

Last Fold - Seal with Tape
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Mini'app'les
P.O. Box 796
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(Continued from page 22)
ruptured on the floor, to the point. .
that sometimes the floor cannot "he
seen for the dead that cover it. Secret
rooms abound, some containing
weapons, some with special mes
sages from Bu.ngie. And much, much
more.

Marathon is completely Power
Mac native and that alone should
play a large role in helping Apple
meet its goal of a million Power
Macs sold in their first year.
•Marathon really shows what Power
Macs are capable of in a way that
faster progress bars do not: real-time
textured mapped 3-D graphics with
interactive lighting effects in 16-bit
color at full screen resolution is awe.
inspiring. This is, in my not unsub
stantial gaming experience, the sin
gle best action game yet produced.
Buy it.

. © 1995 The Savannah Macintosh Users
Group

M a r a t h o n .

• System'7.1 or .better, 68030-
processor or better, Power Macintosh
recommended

• 4MB RAM, 4.5MB RAM for
Power Macintosh, 12MB hard'drive
space• 640 by 480 resolution screen ..
with 8 bit color, 16 bit color
supported

• QuickTime 2.0 and QuickTime
Musical Instruments extensions
needed for MIDI soundtrack
■ •All joysticks and CyberMaxx VR

helmet supported •
• Street Price: $39.95

Jeremy Roush is a student at The
Savannah College of Art and Design;
where.he is the Apple representative for
student Macintosh purchases. He is
also involved in Satellite, the new inter
active services group at SCAD. His
online address is Jeremedia@aol.com.
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Treasurer's Report February 1995
Profit & Loss Statement ...... ..\ .......... . :.. ,'. .... .by Jacque Gay
I n c o m e . . . . ; . .

M e m b e r s h i p s . . . . . . . ' . * . . $ 9 0 . 0 0
A d v e r t i s i n g . . . . . . . . . . . . . : . ' . . . . : ' . . . . . . $ 9 5 . 0 0• Software Sales Net of Sales'Tax ." ...........: :$52.59
F r e i g h t & M i s c . I n c o m e , . . . . $ 4 . 0 0
I n t e r e s t . . . . . . : . . . : , - . . . ' . . . . . . . . . . . . . . . . . $ 9 . 4 1
To t a l I n c o m e . . . . . . . . . . . . . . . . . ' . : . . . . . $ 2 5 1 . 0 0

E x p e n s e s . . . . .
F i n a n c i a l ( T r e a s u r e r ) : .

( $ 2 1 . 0 0 ) . . . . . . . . . . . . . . : . . . . • . . . , . .
P u b l i c a t i o n s / N e w s l e t t e r . $ 3 8 8 . 3 8
H a r d w a r e / R e s o u r c e S u p p o r t . - . . $ 2 1 . 9 6
To ta l Expenses . . . . : . . . . . . . . • " . . ! . . . . . . . . . . $389 .34

N e t P r o fi t / ( L b s s ) . . . . . . : . . . . . . ( $ 1 3 8 . 3 4 )

YOUR
AD

HERE!!
SEE NEWSLETTER AD RATES IN

THIS ISSUE!!

MUG NEWS SERVICE

This Copyright notice per
tains to those articles identified
as being reprinted from GEnie
Lamp publications.

(c) Copyright 1994
T/TalkNET Online Publishing
and GEnie. To join GEnie, set
your modem to 2400 baud (or
less) and half duplex (local
echo). Have the modem dial
1-800-638-8369. When you
get a CONNECT message, type
HHH. AttheU#= prompt,
type: JQINGENIE and hit the
[return] key. When you get the
prompt asking for the signup
code, type DSD524 and hit ■■
RETURN. The system will then
prompt you for your sign-up
information. Call (voice)
1-800-638-9636 for more
information.
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APPLE Macintosh
REPAIR

lYEAR WARRANTY ON LOGIC BOARDS
COMPONENT LEVEL REPAIR
ROCK BOTTOM PRICING
FAST TURNAROUND
ANALOG BOARD REPAIR
FLOPPY DRIVES (800 &FDHD)
HARD DRIVES
POWER SUPPLY UPGRADE

1

!

i
1-612*943-1306

FAX: 612-943-1309
Solutions for Continuing Technology

Soluironi)x
CORPORATION

7255 FLYING CLOUD DRIVE
EDEN PRAIRIE, MN 55344

i
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mini'applesB o x 7 9 6 •
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DAN B BUCHLER
2601 WOODS TRAIL
BURNSVILLE MN 55337
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